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User Michelle only in-charge the Project A and she will not involve in other projects. So she only can create,

read, edit and update the document or account relevant with Project A only.

Before Using this User Default Setting, please make sure the User Default Setting has been ticked and save.
This is additional module, extra charges is occurred.

Step 1 : Click on (File -> Modules). Plesae make sure the User Default Setting has ticked.

& Module Manager

Modules & Features

| General Ledger
| Account Receivable
| Account Payable
~| Stocks
| Sales
| Purchases
<! Multi-Location
| Multi-Currency
~| Project
7| GST/VAT/SST
< Partial Delivery
Manufacturing
| Price Group
<1 Audit Trail
Report Suite
Cost Centre
Serial Number
< POS
| Validation Manager
Points Management
User Defined Fields
< GST Margin Scheme
#| GST Group Registration
] Finance Charge
| Deposit
| Advance Currency
| Layout Customization

o

Batch Email Distribution

| Landing Cost
| Packing Lists
L WTax
| Stack Commission Group

Batch Number
Starter Pack Plus

| Starter Pack
| Free Edition
| Itemized Project Knock-Off

User Default Setting 1.
Partial Exemption

| Recurring
| Progress Invoicing
! Billing Approvals Control
| Customer [/ Supplier Item

Stock Take
Cash Register Integration

| Maybank2e
| Credit Control
| QNE BizPay

QNE BizPay Plus
E-Commerce

| Apply Pricing Rule
| Packing UOM

! Property Management
| Post as Accrued AP

Meter Billing

[ Advance Manufacturing
[ Cash Flow Forecast Advisc

Finished Goods Produce
Fixed Commission Rates
Renewal System

! Packing UOM Summary
[l Consclidated Financial Re|
[ Stock Sub-Code

- o x
~ Tasks A
H Apply Changes

&9 Save & Close 2.

£ Close
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Step 2 : User can find the User Default Setting Default -> User Default Setting

File RYEYM Tools Inquiry Maintenance

® O Nm. 35

Navigation Reports Basic Default  Window

- LISt -
Navigation Appearance  Windows
Navigation M3 x
Default
i@ KIV/Draft

& Security System User

@ Security System Role

(¢ User Default Form Formats
& User Default Role Settings
2, User Default Settings 2.

8 Dashboard

& General Ledger
4 Customer

# Supplier

i+ Sales

% POS

# Purchases

# Stocks

# GST/SST

% Advance Currency
‘< Default 1.

&l Al
Panels Font

Actions

n g

OF
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Step 3 : Once you enter the User Default Setting click on New to create.

VIEW BY PROJECT AND NOT ALLOW SELECT OTHER PROJECT
Step 4 : Select project (E.g. Project A). Next, Tick Viewed by project only. After complete the setting, click

Save.

File BECCH Edit Task Info View Tools Inquiry Maintenance

2% . User Default § =

£ User Default Settings

User 2. MICHELLE

User Default Settings

Supplier Category

7 Allow to select other supplier categery

1.t g.= = ®2 © 7 =) @ © % a2
"New * Save Save and Save and New Audit Reset View View Variants Previous Next Record Search Close

< Close @ Trail Settings < Record
Records Creation Save View Records Navigation Close

Deposit To /| Allow to select other deposit to Viewed by deposit to only
Agent -| [~ Allow to select other agent Viewed by agent only
Purchaser ~ Allow to select other purchaser Viewed by purchaser only
Location - Allow to select other location Viewed by location only
Project T T — Z Viewedibyprojectonly e
Stock Category From © To Filter by this category only
Stock Group From - To Filter by this group only

Stock Class From | To Filter by this class only
Customer Category ~ Allow to select other customer category Filter by customer category only

Filter by supplier category only

Compulsory Select Agent
Compulsory Select Purchaser
Compulsory Select Location Compulsory Select Detail Location
Compulsory Select Project Compulsory Select Detail Project
Compulsory Select Category

Compulsory Select Group

Compulsory Select Class
Compulsory Select Customer Category

Compulsory Select Supplier Category

Step 5: When Michelle login the transaction example Sales -> Quotation, system only shows Project A. User not

allow to see and choose other projects. Since “Allow to select other project” is unticked.

%* - Quotations x

W Quotations

Details | Customer | DO Address | Others | Notes | [l Files | Info | JomPay

Customer Currency RM
To Attention
Delivery Term Agent
Term C.0.D. -| Validity
Location Project  Project A
O ||Scan Item.. ® X ¢ & d @ £ Evewvaiansr @ @ ® [/ v |2
Stock... | Description Qty |UOM |Un..|Disc |A.. |Ta..|Tax |Net
Taxable Tax 0.00 Rounding Adj

Rate 1.00000000 Exchange Rate
18/11/2021
Quotation No. Project A-QT2111/001

Doc Date

Reference No.

Tax Inclusive | Rounding

Due Amount
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Step 6: View -> Report -> Project -> Project Profit & Loss Acount -> Project Profit & Loss Acount with details,
user can only view Project A report . Since “View by Project is Ticked” means user only can view own project

Project Profit And Loss Account With Details - QNE Business Solutions

File BallCl Edit View Tools Inquiry Maintenance

< < -

G o d = < @
Design Print Preview Add/Remove Inquiry Close

o = in Favorites
View Close

Navigation 1 % = OProject Profit And ~
Default
@ KIV/Draft
& Security System User
@ Security System Role
(& User Default Form Formats

Filter Inquiry

Title Profit & Loss With Detail 18 November, 2021

¥ User Default Role Settings ~ Filter Options
2, User Default Settings
Projects {Project A
& Dashboard Date From | 01/01/2021
& General Ledger Show Level
& Customer
# Supplier ~ Other Options
* Sales Display Total
& POS Include Zero
* Purchases Wi Ratl "

Include Retained Eamnings B/F and C/F
¥ Stocks Show Manufacturing Account In Details
# GST/SST
% Advance Currency
4= Default

2] Project Profit And Loss Account With Details

18/11/2021

SELECT MORE THAN ONE PROJECTS, NOT ALLOW TO SELECT THE OTHER PROJECT AND VIEWED BY

PROJECT ONLY.

Step 7: If User has set 2 project (Project A & B) in the User Default Setting, and tick View by Project only

| &% - User Default § ~
| 2. User Default Settings

| User MICHELLE

User Default Settings

Deposit To 7 Allow to select cther deposit to

Agent -| [~ Allow to select other agent

Purchaser - Allow to select other purchaser

Location ~ Allow to select other location

Project Project A: Pro... - Allow to select other project
[odeccAl) |

Stock Category From - Project A: Project A
- Project B: Project B
Project C: Project C

Project D: Project D
OK | Cancel

Stock Group From
Stock Class From

Customer Category ~ Allow to select other customer category

Supplier Category - Allow to select other supplier category

Viewed by deposit to only
Viewed by agent only
Viewed by purchaser only
Viewed by location only

- Viewed by project only
Filter by this category only

- Filter by this group only
Filter by this class only

Filter by customer category only

Filter by supplier category only

Compulsory Select Agent
Compulsory Select Purchaser
Compulsory Select Location
Compulsory Select Project
Compulsory Select Category
Compulsory Select Group
Compulsery Select Class

Compulsory Select Customer Category

Compulsory Select Supplier Category

Compulsory Select Detail Location

Compulsory Select Detail Project
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Step 8: The user is able to select Project A and Project B in their user account but cannot select other projects

@* - Quotations x

% Quotations

Details | Customer | DO Address_Others_Notes_LFlIes_Info JomPay

Customer | Currency RM Rate 1.00000000 Exchange Rate
To Attention Doc Date 17/11/2021

Delivery Term Agent ° Quotation No. QT2111/013

Term C.0.D. - Validity Reference No.

Location "| | Project Tax Inclusive Rounding

Project... =~ Description
» [Project A Project A

O ||Scan Item.. = X ¢ & %O o B View Variants - Project B Project B
Stock... | Description Qty|UOM | Un...|Disc A
New | Reload
Taxable Tax 0.00 Rounding Adj Due Amount

Step 9: In the reporting, user can also view Project A and Project B only

@* - Quotations O Project Profit And =

] Project Profit And Loss Account With Details

Filter Inquiry
Title Profit & Loss With Detail 17 November, 2021

~ Filter Options

Projects ALL PROJECTS k]

Date From Project Code = | Description To  |17/11/2021
+ [Project A Project A

Show Level Project B Project B

~ Other Optiong

Display Tot
Include ZerfPress Arrow or Tab to navigate search column.Press Ctrl + F to
With Ratio L2 —

Include Retained Earnings B/F and C/F

Show Manufacturing Account In Details
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SELECT 2 PROJECTS, ALLOW TO SELECT OTHER PROJECT AND TICK VIEWED BY PROJECT ONLY.

Step 10: If user has set 2 project (Project A & B) in the User Default Setting, tick Allow to select other project,

tick View by Project only

| 2% - User Default S =

| 2. User Default Settings

[ User MICHELLE
User Default Settings

Deposit To - Allow to select other deposit to Viewed by deposit to only
Agent - Allow to select other agent Viewed by agent only Compulsory Select Agent
Purchaser - Allow to select other purchaser Viewed by purchaser only Compulsory Select Purchaser
Location - Allow to select other location Viewed by location only Compulsory Select Location
Project _Nlcw to select other project - Viewed by project only Compulsory Select Project
Stock Category From E Project A: Project A i - Filter by this category only Compulsory Select Category

< Project B: Project B
Stock Group From Project C: Project C -| [« Filter by this group anly Compulsory Select Group
Stock Class From Prq‘e:‘;:: P::::‘D -| [ Filter by this class only Compulsory Select Class
i listmen Catesiony -| [ Allow to select other customer category Filter by customer category only Compulsory Select Customer Category
Supplier Category .| < Allow to select other supplier category Filter by supplier category only Compulsory Select Supplier Category

Compulsory Select Detail Location

Compulsory Select Detail Project

Step 11: User can view and select other project other thanProject A & Project B

@ Sales Orders

Detais ‘Cusmmar |nc Address |omars | Notes | [ Files | Approvals |Infn | JomPay |

Customer | -

Currency  |RM Rate 1.00000000 Exchange Rate
To [ | Attention | | Docpate | 23112021 -]
Delivery Term | | Agent \ -] s onderno. [s02111008 -
Term [coo. -| Require Date | - No. | |
| g e S

[Prosect code [ Deserinton
Il Xe oo B GO [ View| * iProjecta Project A

|-"_"smclfcme ‘s& Sub-Co ‘Descripﬁnn |BatchNn |F.Desc |Ql Project Project 8 |
Project C Praject C

»
Project D ProjectD

BB BBBBE
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Step 12: But user is not able to view other project’s Report since “View by Project Only” is ticked

Options | Inquiry

Start Date

Account No

All projects

12 Project Selection

Project Ledger

(f]Fiter |[ ] Account Selection

No project

| Project A: Project A
| Project B: Project B

Sub Projects

- | End Date

- To

Main projects

29/11/2021

®) Sub projects

COMPULSORY SELECT PROJECT OR COMPULSORY SELECT DETAIL PROJECT.

Step 13: If user ticked Compulsory Select Project

2* - User Default S

User
User Default Settings
Deposit To
Agent
Purchaser

Location

Project

Stock Group From
Stock Class From
Customer Category

Supplier Category

Stock Category From

2. User Default Settings

MICHELLE

~ Allow to select other deposit to
~ Allow to select other agent

~ Allow to select other purchaser
~ Allow to select other location

- Allow to select other project

7 Project A: Project A
- Project B: Project B
Project C: Project C

Project D: Project D
OK | |Cancel

- Allow to select other customer category

- Allow to select other supplier category

Viewed by deposit to only
Viewed by agent only
Viewed by purchaser only

Viewed by location only

< \iewed by project anly

Fiter by this category only

- Filter by this group only

Filter by this class only

Filter by customer category only

Filter by supplier category only

Compulsory Select Agent
Compulsory Select Purchaser
Compulsory Select Location
Compulsory Select Project
Compulsory Select Category
Compulsory Select Group

Compulsory Select Class

Compulsory Select Customer Category

Compulsory Select Supplier Category

Compulsory Select Detail Location

Compulsory Select Detail Project
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User should update project in the header else error message will be prompt as below and not allow to save

@* - Quotations x

@@ Quotations

Details | Customer | DO Address | Others | Notes | (*) Files | Info | JomPay

Customer 700-A001 Currency RM Rate 1.00000000 Exchange Rate
To ADVANCE TRADING SDN. BHD. Attention Ms. Lee Pui San Doc Date 18/11/2021 -
Delivery Term Agent CINDY -| Quotation No. |QT2111/013
Term C.0.D. Validity Reference No.
Location Project Tax Inclusive Rounding

« Validation Error - o x

Problems were detected during data validation.
Please read the information below to understand
what the issues are and how you can correct
them.

(X

Target
" (Quotations, ) 'Project’ must not be empty.

+ | Description

Close

Step 14: If user ticked Compulsory Select Detail Project

2% - User Default S

2. User Default Settings

User MICHELLE
User Default Settings
Deposit To “ Allow to select other deposit to
Agent < Allow to select other agent
Purchaser < Allow to select other purchaser
Location ~ Allow to select other location
Project !AHBW to select other project

[ (select All

Stock Category From

- Project B: Project B
Project C: Project C
Project D: Project D

OK | |Cancel

Stock Group From

Stock Class From

Customer Category * Allow to select other customer category

Supplier Category Allow to select other supplier categery

Viewed by deposit to only
Viewed by agent only
Viewed by purchaser only

Viewed by location only

< \iewed by project anly

Fiter by this category only

- Filter by this group only

Filter by this class only

Filter by customer category only

Filter by supplier category only

Compulsory Select Agent
Compulsory Select Purchaser
Compulsory Select Location Compulsory Select Detail Location
Compulsory Select Project Compulsory Select Detail Project
Compulsory Select Category

Compulsory Select Group

Compulsory Select Class

Compulsory Select Customer Category

Compulsory Select Supplier Category
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User should update Detail Project in the transaction else system not allow to save

% Quotations
Details | Customer | DO Address | Others | Notes | [ Files | Info | JomPay
Customer 700-A001 ~ | Currency RM Rate 1.00000000 Exchange Rate
To ADVANCE TRADING SDM. BHD. | Attention Ms. Lee Pui San Doc Date 29/08/2021 .-
Delivery Term Agent CINDY | Quotation Ho. QT2106/013 -
Term C.0D. -| validity Reference Ho.
Locates ~ | emiect Tax Inclusive Rounding
0% & ¥ |saniem. | | @ @@ ViewVarionts~ @ G | @ @ ® [g - |18
Stock Code | Description Qty uom Unit Pr.__ | Disc Amount | Tax C. Tax Net Project
» ASUS-EX ASUS TECH EX MOTHERBO 1 UNITS 280.00 12% 230.00 246.40
Taxable 246,40 Tax 0.00 Rounding Adj Due Amount 246,40
+ Validation Error - o X
@ Problems were detected during data validation. Please read

the information below to understand what the issues are
and how you can correct them.

Target ~ | Description

‘atPos 1' ‘Detail Project’ must not be empty.
(Quotation Details,

c46de346-78ad-48

' at Pos 2' ‘Detail Project’ must not be empty.
(Quotation Details,
e44055f2-96b-48e

Close




